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Microsoft OneNote cheat sheet
Frequently used shortcuts
Ctrl + Shift + G

Put the focus on the current section

Ctrl + Shift + G or

Open the context menu

Shift + F10
Ctrl + N

Add a new page at the end of the
selected section

Alt

Open the ribbon

Alt + H

Open the Home tab

Alt + N

Open the Insert tab

Alt + D

Open the Draw tab

Alt + W

Open the View tab

Narrator

Ctrl + O

Open a notebook

Ctrl + G

then press the Down or Up arrow

Win + Enter

Activate Narrator in Windows

key to select a different notebook,

Caps Lock + Esc

Exit Narrator

and then press Enter Switch to a
different notebook on the
Navigation bar

Type and edit notes

Ctrl + T

Create a new section

Ctrl + M

Ctrl + Alt + N

Create a new page below the

Ctrl + Shift + M or Create a Quick Note

current page tab on the same level

Win + Alt + N

Open a new OneNote window

Ctrl + Alt + Shift + Create a new sub-page below the

Ctrl + Alt + D

Dock the OneNote window

N

current page

Ctrl + Z

Undo the last action

F11

Enable or disable the full page view

Ctrl + Y

Redo the last action

Ctrl + Alt + G

Put the focus on the current page

Ctrl + X

Cut the selected text or item to the

tab

Clipboard

Ctrl + Alt + M

Move or copy the current page

Ctrl + Shift + A

Select the current page

Ctrl + Shift + T

Jump to the title of the page and

Ctrl + V

Paste the contents of the Clipboard

select it

Home

Move to the beginning of the line

Open a search box to search all

End

Move to the end of the line

Left arrow

Move one character to the left

Right arrow

Move one character to the right

Ctrl + Left arrow

Move one word to the left

Ctrl + E

currently open notebooks
Alt + F1

Show / hide open notebooks

Navigation

Ctrl + C

Copy the selected text or item to
the Clipboard

Ctrl + Right arrow Move one word to the right

Using these keys, you can navigate through OneNote

Backspace

Delete one character to the left

Del

Delete one character to the right

Ctrl + Backspace

Delete one word to the left

canvas

Ctrl + Del

Delete one word to the right

Down arrow

Move to the ribbon on a tab

Shift + Enter

Insert a line break without starting a

Left arrow / Right

Move among the options on a

arrow

ribbon

for Windows 10 without using mouse.
F6

Jump between the tab bar,
navigation pane, and the page

Enter

Execute the currently selected
option

Left arrow / Right

Move between tabs

Shift + F10 or

Open the context menu for the

Context menu key object in focus
Ctrl + Shift + W

Execute the action suggested on
the Information Bar if it appears at
the top of a page

arrow
Shift + Tab

new paragraph

Move between the items on the
main menu bar

Format notes
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Ctrl + Shift + H

Highlight the selected text

Ctrl + K

Insert a hyperlink

Alt + Shift + Left

Ctrl + Shift + C

Copy the formatting of the

arrow

selected text (Format Painter)

Shift + Tab

Ctrl + Shift + V

Enter

Increase paragraph indent

selected text (Format Painter)

Ctrl + R

Right-align the selected paragraph

Open a hyperlink when the cursor

Ctrl + L

Left-align the selected paragraph

is in the link text. Press the arrow

Ctrl + Shift + >

Increase the font size of selected

text

text
Ctrl + Shift + <

Apply bold formatting to or remove
it from the selected text

Ctrl + I

(at the beginning of a line)
Decrease paragraph indent

Paste the formatting to the

keys to move the cursor to the link

Ctrl + B

Decrease paragraph indent

Decrease the font size of selected
text

Ctrl + Shift + R

Apply italic formatting to or

Show or hide rule lines on the
current page

remove it from the selected text
Ctrl + U

Apply underline to or remove it
from the selected text

Ctrl + -

(-) Apply strikethrough to or

Add items to a page
Win + Shift + S

Clipboard (requires the Windows

remove it from the selected text
Ctrl + Shift + =

Ctrl + =

Ctrl + .

10 Creators Update)

Apply superscript formatting to or
remove it from the selected text

Alt + Shift + D

Insert the current date

Apply subscript formatting to or

Alt + Shift + F

Insert the current date and time

remove it from the selected text

Alt + Shift + T

Insert the current time

Apply bulleted list formatting to or

Shift + Enter

Insert a line break

remove it from the selected

Alt + =

Start a math equation or convert

paragraph
Ctrl + /

Apply numbered list formatting to

selected text to a math equation
Tab

or remove it from the selected
paragraph
Ctrl + Alt + 1

Ctrl + Alt + 3

Ctrl + Alt + 5

Ctrl + Shift + N

Create a row below the current row
in a table

Alt + Enter

Create another paragraph in the
same cell in a table

Ctrl + Alt + R

Create a column to the right of the
current column in a table

Enter

Create a row above the current one
in a table (when the cursor is at the

current note

beginning of any row, except for

Apply Normal style to the current

the first row)

Increase paragraph indent

arrow
Tab

Ctrl + Enter

Apply Heading 6 style to the

note, clearing all formatting
Alt + Shift + Right

Create another row when in the last
cell in a table

Apply Heading 5 style to the
current note

Ctrl + Alt + 6

Enter

Apply Heading 4 style to the
current note

Create another column in a table
with a single row

Apply Heading 3 style to the
current note

Ctrl + Alt + 4

Tab

Apply Heading 2 style to the
current note

Create a table by adding a second
column to already typed text

Apply Heading 1 style to the
current note

Ctrl + Alt + 2

Copy a screen clipping to the

Del

(press twice) Delete the current
empty row in a table (when the
cursor is at the beginning of the

(at the beginning of a line)

row)
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Select notes and objects

Tag notes

Ctrl + A

Select all items on the current

Ctrl + 1

Apply, mark, or clear the To Do tag

page. To expand the selection,

Ctrl + 2

Apply or clear the Important tag

Ctrl + 3

Apply or clear the Question tag

Ctrl + 4

Apply or clear the Remember for

keep pressing Ctrl + A
Shift + End

Select from the current cursor
position until the end of the line

Shift + Down

Select the whole line (when the

arrow

cursor is at the beginning of the

later tag
Ctrl + 5

Apply or clear the Definition tag

line)

Ctrl + 6

Apply or clear the Highlight tag

Jump to the title of the page and

Ctrl + 7

Apply or clear the Contact tag

select it

Ctrl + 8

Apply or clear the Address tag

Esc

Cancel the selected outline or page

Ctrl + 9

Apply or clear the Phone Number

Alt + Shift + Up

Move the current paragraph or

arrow

several selected paragraphs up

Ctrl + Shift + T

tag
Ctrl + 0

selected notes

Alt + Shift + Down Move the current paragraph or
arrow

several selected paragraphs down

Alt + Shift + Right

Move the current paragraph or

arrow

several selected paragraphs right
(increasing the indent)

Remove all note tags from the

Use outlines
Alt + Shift + 1

Show through Level 1

Alt + Shift + 2

Expand to Level 2

Alt + Shift + Left

Move the current paragraph or

arrow

several selected paragraphs left

Alt + Shift + 3

Expand to Level 3

(decreasing the indent)

Alt + Shift + 4

Expand to Level 4

Select the current paragraph and

Alt + Shift + 5

Expand to Level 5

Alt + Shift + 6

Expand to Level 6

Alt + Shift + 7

Expand to Level 7

Alt + Shift + 8

Expand to Level 8

Alt + Shift + 9

Expand to Level 9

Alt + Shift + 0

Expand all levels

Tab

Increase indent by one level

Shift + Tab

Decrease indent by one level

Alt + Shift + +

Expand a collapsed outline

Alt + Shift + -

Collapse an expanded outline

Ctrl + Shift + -

its subordinate paragraphs
Del

Delete the selected note or object

Home

Move to the beginning of the line

End

Move to the end of the line

Left arrow

Move one character to the left

Right arrow

Move one character to the right

Alt + Left arrow

Go back to the last visited page

Alt + Right arrow

Go forward to the next visited page

Ctrl + Alt + P

Play selected audio recording

Ctrl + Alt + S

Stop playback of selected audio
recording

Ctrl + Alt + A

Start new audio recording

Ctrl + Alt + Y

Rewind the current audio recording
by 10 seconds

Specify language settings
Note: To change the writing direction in notes, you
must enable right-to-left languages in the Microsoft
Office Language Preferences tool.

Ctrl + Alt + T

Rewind the current audio recording
by 5 minutes

Ctrl + Alt + U

Fast-forward the current audio
recording by 10 seconds

Ctrl + Alt + I

Ctrl + Left Shift

Set left-to-right writing direction

Ctrl + Right Shift

Set right-to-left writing direction

Tab

Increase indent by one level in
right-to-left text

Fast-forward the current audio
recording by 5 minutes

Shift + Tab

Decrease indent by one level in
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right-to-left text

+
Ctrl + Alt + - or Ctrl (– on the numeric keypad) Zoom

Work with pages and Quick Notes
F11

Enable or disable full page view

Ctrl + M

Open a new OneNote window

Ctrl + Shift + *

Expand or collapse the tabs of a

+ Alt + Shift + -

out

Ctrl + S

Save changes and sync notebook

Not: OneNote çalışırken, notlarınız her değiştirildiğinde
otomatik olarak kaydedilir. Notları elle kaydetmek
gerekmez.

page group
Ctrl + P

Print the current page

Ctrl + N

Add a new page at the end of the

Ctrl + Shift + [

Ctrl + Shift + ]

Ctrl + Alt + N

Work with notebooks and sections

selected section

Ctrl + O

Open a notebook

Increase the width of the page tabs

Ctrl + T

Create a new section

bar

Ctrl + Tab

Go to the next section

Decrease the width of the page

Ctrl + Shift + Tab

Go to the previous section

tabs bar

Ctrl + Page Down Go to the next page in the section

Create a new page below the

Ctrl + Page Up

current page tab at the same level
Ctrl + Alt + Shift + Create a new sub-page below the
N

current page

Ctrl + A

Select all items. To expand the
selection, keep pressing Ctrl + A

Ctrl + Alt + G

Select the current page

Alt + Shift + Up

Move the selected page tab up

arrow

Go to the previous page in the
section

Alt + Home

Go to the first page in the section

Alt + End

Go to the last page in the section

Ctrl + Alt + M

Move or copy the current page

Ctrl + Alt + G

Put focus on the current page tab

Ctrl + Shift + G

Put focus on the current section tab

Ctrl + G

then press the Down or Up arrow
keys to select a different notebook,

Alt + Shift + Down Move the selected page tab down

and then press Enter Switch to a

arrow

different notebook on the

Ctrl + Shift + T

Move the cursor to the page title

Page Up

Scroll up on the current page

Ctrl + Shift + G or

Open the context menu of the

Page Down

Scroll down on the current page

Shift + F10

current section

Ctrl + Home

Scroll to the top of the current page

Ctrl + End

Scroll to the bottom of the current
page

Navigation bar

Search notes
Ctrl + E or Ctrl + F Open a search box to search all

Ctrl + Down arrow Go to the next paragraph
Ctrl + Up arrow

Go to the previous paragraph

Alt + Down arrow

Go to the next note container

Home

Go to the beginning of the line

End

Go to the end of the line

Left arrow

Move one character to the left

Right arrow

Move one character to the right

Alt + Left arrow

Go back to the last visited page

Alt + Right arrow

Go forward to the next visited page

Ctrl + Alt + + or

(+ on the numeric keypad) Zoom

Ctrl + Alt + Shift + in

currently open notebooks
Down arrow

While searching all notebooks,
preview the next result

Enter

While searching all notebooks, go
to the selected result

Press Ctrl+E, Tab, Tab, Down arrow to change the
search scope
Esc

Dismiss Search and return to the
page

Share notes with other people
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Ctrl + Shift + E

Open the Share pane

Ctrl + Shift + E

then press Tab, Tab, Enter to
create a sharing link for the
current page

Ctrl + Shift + E

then Tab, Down arrow, Down
arrow to share the current
notebook

Ctrl + Shift + E

then Enter to send a copy of the
page via another app

Share notes with other programs
Ctrl + Shift + E

then Enter to send a copy of the
current page via another app

Ctrl + S or Shift +

Sync current notebook

F9
F9

Sync all notebooks

Ctrl + Q

Mark the current page as read or
unread

Protect notes
Ctrl + Alt + L

Lock all password-protected
sections

More
Ctrl + Alt + 7

Give feedback to Microsoft

If you want o use accessibility options to navigate in
OneNote, please refer to this page.
To get started using a screen reader with OneNote,
refer to this page.
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